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1. Inleiding 

1.1 Welkom 

Welkom bij de Scia Engineer Installatie Handleiding. Scia Engineer is een 
berekeningsprogramma onder Windows XP/2003/Vista/Windows 7 met een breed 
toepassingsbereik: van de controle van eenvoudige raamwerken tot het 
geavanceerde ontwerp van complexe projecten in staal, beton, hout,... 

Het programma behandelt de berekening van 2D/3D raamwerken, met inbegrip van 
profielcontrole en controle van verbindingen voor staalconstructies. Naast 
raamwerken is het ook mogelijk plaat en schaal structuren te dimensioneren met 
inbegrip van geavanceerde betonberekeningen. 

Deze handleiding beschrijft de procedures voor een correcte installatie van het 
programma. 

Het tweede hoofdstuk beschrijft welk hoofdstuk nodi g is voor elk type 
installatie. Het is aangeraden eerst dit hoofdstuk te lezen. 

In de hoofdstukken drie, vier en vijf worden vervolgens alle installatietypes volledig 
toegelicht. 

In hoofdstuk zes wordt afgesloten met de eventuele te volgen uninstall-procedure. 

 

1.2 Systeemvereisten 

Om Scia Engineer te kunnen installeren, is het aangeraden om over de volgende 
systeemvereisten beschikken: 

1.2.1 Hardwarevereisten 

Processorsnelheid Pentium IV - 3Ghz 
(Aanbevolen: DualCore2 3 Ghz of hoger) 

RAM 2 GB (Aanbevolen: > 3 GB) 

Grafische kaart 256 MB, ondersteuning van OpenGL 

Vrije schrijfruimte voor 
programma, projecten en tijdelijke 
bestanden 

5 GB 

Minimale resolutie 1280 x 800 
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1.2.2 Softwarevereisten 

Standalone protection 

Windows 2003 server 
Windows XP 32/64 bit    
Vista 32/64 bit            
Windows 7 - 32/64 bit 

 

Het wordt aanbevolen de laatst beschikbare Service 
Pack voor deze besturingssystemen te installeren 

behalve SP3 voor Windows XP. 

Floating protection 

De FlexNET draait op: 
Windows XP 32/64 bit                                        
Windows Vista 32/64 bit 
Windows 2008 server 64 
bit Windows 7 - 32/64 bit 

 

Het wordt aanbevolen de laatst beschikbare Service 
Pack voor deze besturingssystemen te installeren 

behalve SP3 voor Windows XP.                                                            

Allplan Scia Engineer 2011 is enkel compatibel met:  

Allplan 2009.0 
Allplan 2011.0 

Allplan Precast 2010.0 
 

Men moet eerst Allplan installeren en daarna Scia 
Engineer want anders wordt Allplan niet correct 

herkend. 

Revit Scia Engineer 2011 is enkel compatibel met:                
Revit 2009                                                               
Revit 2010 

De Revit-link is beschikbaar op                       
www.scia-online.com/revit 

Etabs Scia Engineer 2011 is compatibel met:                              
Etabs 9.2 

IFC Scia Engineer 2011 is enkel compatibel met:      
IFC version 2x3 

SDNF Scia Engineer 2011 is enkel compatibel met             
version 2 

Tekla Scia Engineer 2011 is enkel compatibel met:          
Tekla v 15.0 and hoger 
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2. Welk hoofdstuk heeft u nodig voor uw installatie? 

In deze handleiding worden 3 mogelijke installatietypes beschreven voor de installatie 
van Scia Engineer: 

 

• LOKALE INSTALLATIE, LOKALE PROTECTIE (Hoofdstuk 3 ) 

Bij dit type installatie worden zowel Scia Engineer als de protectie op de 
(client) computer geïnstalleerd. 

  

• LOKALE INSTALLATIE, NETWERK PROTECTIE (Hoofdstuk 4 ) 

Bij dit type installatie wordt Scia Engineer op elke client computer 
geïnstalleerd. De protectie anderzijds, wordt geïnstalleerd op een netwerk 
(server). 

 

• SERVER - CLIENT INSTALLATIE (Hoofdstuk 5 ) 

Bij dit type installatie worden zowel Scia Engineer als de protectie op de 
server (netwerk) geïnstalleerd. 
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3. Lokale Installatie, Lokale Protectie  

3.1 Installatie van de Sentinel Dongle Protectie 

Indien de protectie verzorgd wordt door een hardware lock, dienen volgende stappen 
ondernomen te worden: 

• installatie Sentinel Protection Installer  

• plaatsing Sentinel Dongle 

 

3.1.1 Installatie van de Sentinel Protection Installer 

De Sentinel Protection Installer verzorgt de communicatie tussen Scia Engineer en de 
Sentinel Dongle. 

Kies in het Installatie & Software menu van de installatie-DVD voor Installeer 
Sentinel Driver . Volg de installatie-instructies op het scherm. 

De Sentinel Protection Installer kan ook manueel geïnstalleerd worden via 
X:\Tools\Sentinel\ Sentinel Protection Installer 7. *.exe waarbij X staat voor de 
aanduiding van het DVD-station en * voor de versie. 

� Opmerking 

Indien reeds een oudere versie van de Sentinel Syst em Driver of de Sentinel 
Protection Installer aanwezig is, dan dient deze ee rst via het configuratiescherm 
verwijderd te worden alvorens u de nieuwe Sentinel Protection Installer kan 
installeren. 

 

3.1.2 Plaatsing van de Sentinel Dongle 

De Sentinel hardware locks, in de vorm van een dongle, zijn beschikbaar in twee 
versies: ofwel voor plaatsing op een USB-poort ofwel op een parallelle poort. Plaats uw 
dongle op een vrije poort van de computer. Voor een parallelle lock wordt aangeraden 
het lock te plaatsen wanneer de computer is uitgeschakeld. 

 

3.1.3 Controle van de Sentinel Dongle 

Om de correcte installatie van de Sentinel Dongle te controleren, kan gebruik gemaakt 
worden van de Sentinel SuperPro Medic. 

 

3.1.3.1 Installatie Sentinel SuperPro Medic 

1. Ga via Windows Verkenner naar X:\Tools\Sentinel\  waarbij X staat voor de 
aanduiding van het DVD-station. 
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2. Start het bestand SuperproMedic.exe en volg de instructies op het scherm. 

3. De SuperPro Medic wordt standaard geïnstalleerd in de map C:\Program 
Files\Rainbow Technologies\SuperPro\Medic . 

 

3.1.3.2  Controle werking dongle 

1. Ga via Windows Verkenner naar C:\Program Files\Rainbow 
Technologies\SuperPro Medic . 

2. Start het bestand SuperproMedic.exe : De SuperPro Medic verschijnt op het 
scherm. 

3. In de rechter bovenhoek van de SuperPro Medic wordt de versie van de 
geïnstalleerde Sentinel Driver weergegeven. Indien hier geen versie wordt 
weergegeven, dient de Sentinel Protection Installer geïnstalleerd te worden zoals 
hierboven aangegeven. 

 
4. Bij Server Name/IP or Mode  dient de optie STANDALONE  gekozen te worden. 

5. Vervolgens kan via [Find SuperPro]  naar correct geïnstalleerde Sentinel dongles 
gezocht worden. Een dialoogvenster verschijnt met de melding van het aantal 
gevonden dongles. 

6. Indien echter geen Sentinel dongles kunnen gevonden worden dan kan via [Medic 
Says] extra informatie worden opgevraagd om het probleem te achterhalen. 

Indien de SuperPro Medic aangeeft dat de Sentinel dongle succesvol wordt 
teruggevonden, dan betekent dit dat de dongle correct gepositioneerd is op de parallelle- 
of USB-poort en dat de Sentinel Protection Installer correct geïnstalleerd is. 
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3.2 Installatie Scia Engineer 

1. Plaats de installatie-DVD van Scia Engineer in de DVD-lade van de computer. 
Het startscherm verschijnt automatisch. Kies de gewenste taal om het menu te 
doorlopen. Het Hoofdmenu  verschijnt. 

  

In het Hoofdmenu  kiest u vervolgens de optie Installatie & Software . 

2. In het Installatie & Software  -menu kiest u vervolgens de optie Installeer Scia 
Engineer  
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� Opmerking 

Indien het startscherm niet kan getoond worden door  het ontbreken van de 
benodigde ActiveX component, kan de installatie ook  manueel gestart worden via 
Windows Verkenner. Start het bestand X:\Setup\DISK1 \Setup.exe waarbij X staat voor 
de aanduiding van het DVD-station. 

 

3. In het Kies het Setup Type om te installeren -menu kiest u vervolgens de 
optie Installeer Enkel op-zichzelf-staand  

  

4. In het dialoogvenster dat verschijnt, kan de gewenste taal voor de installatie 
gekozen worden: 

 

De taal welke gekozen wordt voor de installatie, is ook de standaard taal die 
gekozen wordt voor de helpbestanden van Scia Engineer. 

5. Het welkomstscherm voor de installatie verschijnt. 
Druk op [Volgende]  om verder te gaan. 

6. Bij de Klantgegevens  kan de bedrijfsnaam en de gebruikersnaam worden 
ingevoerd. De bedrijfsnaam komt automatisch op het document van Scia 
Engineer. 
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Druk op [Volgende]  om verder te gaan. 
 

7. In het venster Doellocatie  kan het pad waar de bestanden worden 
geïnstalleerd, worden ingesteld. Standaard gebeurt dit in de map Program Files. 
Het wordt aangeraden deze standaardlocatie te behouden. 

 

Druk op [Volgende]  om verder te gaan. 
 

8. In het venster Type Installatie  kan de gewenste installatievorm gekozen 
worden. 
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Druk op [Volgende]  om verder te gaan. 

 

� Opmerking 

Bij een Standaard-installatie worden NIET alle taal modules geïnstalleerd, enkel de 
Engelse taal en de taal gekozen voor installatie. I ndien u ook andere talen wenst te 
installeren, zoals bijvoorbeeld Frans of Duits, dan  dient u voor een Aangepaste 
installatie te kiezen waarbij meerdere talen kunnen  worden aangevinkt. 

 

Om in het programma een andere taal voor de werkrui mte of de uitvoer te kunnen 
kiezen dient aan twee voorwaarden voldaan te zijn: 

• De desbetreffende taal dient geïnstalleerd te zijn.  

• De benodigde taalmodule dient actief te zijn in de dongle of op de server. 

Om één van de Scia Engineer plug-ins te installeren, dient de plug-in in de 
aangepaste installatie geselecteerd te worden. 
De volgende plug-ins zijn beschikbaar: Tekla Structures plug-in, Revit Structure plug-
in, CADS RC Link Designer, BS2000, Pipeline Wizard,  Composite Beam, Composite 
Column, Arcelor Mittal-Cellular beams. 
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9. In het venster Protectie standaard waarden  kunnen de default-instellingen 
gedaan worden voor de beveiliging. 

 

• Kies voor Enkel op-zichzelf-staand . 

• Vink de optie activeer licentie na het beëindigen van de setup aan. Deze 
optie zorgt dat het licentiebestand onmiddellijk gebruikt wordt na het 
installeren van deze protectiesoftware. 

• Geef het Sleutelnummer  van uw dongle in (6 cijfers). 

o Indien u gebruik maakt van een USB-dongle zal dit nummer beginnen 
met 55xxxx. 

o Indien u gebruikt maakt van een parallelle dongle, heeft de dongle 
slechts 4 cijfers. In dit geval zal u ‘50’ voor dit nummer moeten tikken 
om aldus een 6-cijferig nummer te verkrijgen. Zo zal bijvoorbeeld 
‘501111’voor het nummer ‘1111’ ingevoerd moeten worden. 

 

Dongle Sleutel 
nummer 

 

 

550791 

 

 

 

552430 
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505228 

 

 

 

 

506305 

 

• Vin kook de optie “Load licence from online Scia storage” aan. Met deze 
optie zal het protectiebestand van de dongel automatisch gedownload 
worden van internet en geupdate worden. 

• Indien u het exacte nummer van uw dongle niet kent of indien de dongle niet 
op de computer geplaatst is, vink dan de optie activeer licentie na het 
beëindigen van de setup niet aan. U kunt uw dongle later nog plaatsen en 
activeren. 

 

Druk op [Volgende]  om verder te gaan. 

 

� Opmerking 

Wanneer u een enkel-op-zichzelf-staande dongle gebruikt en een FlexNET netwerk 
licentie, kies dan voor de optie ‘Eerst op-zichzelf -staand, dan floating’, of ‘Eerst 
floating, dan op-zichzelf-staand’. 
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10. In het venster Standaardinstellingen programma  worden de 
standaardinstellingen gedaan met betrekking tot het hanteren van de nationale 
normen. 

 

Kies hier uw standaard keuze voor de Nationale norm en voor uw standaard 
meetsysteem. 

Druk op [Volgende]  om verder te gaan. 

 

11. In het laatste venster zijn de door u gemaakte installatie-instellingen opgelijst. 
Zo kunt u eenvoudig controleren en na eventuele aanpassingen overgaan tot de 
effectieve installatie. Druk hiervoor op [Volgende] . 
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12. Na de installatie verschijnt de melding dat Scia Engineer met succes 
geïnstalleerd is. Druk op [Voltooien]  om de installatie te beëindigen. 

 

 

� Opmerking 

Indien UAC (User Access Control) is geactiveerd, za l het volgende scherm 
verschijnen op het einde van de installatie: 

 

 

Kies voor ‘Install this driver software anyway’ om de installatie te voltooien. 
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� Let op! 

Voor het gebruik van Scia Engineer volstaan standaa rd gebruikersrechten, hier zijn 
geen Administrator rechten nodig.  

Wel dient de gebruiker lees- en schrijfrechten te h ebben op de mappen van Scia 
Engineer:  

Windows XP: C:\Documents and Settings\#USER#\ESA** 

Windows Vista, Windows 7: C:\USERS\#USER#\ESA** 

Waarbij ** staat voor de versie en #USER#  voor de gebruikers login naam.  

 

3.3 Start Scia Engineer 
Dubbelklik op het Scia Engineer 2011.0  -symbool om het programma te starten. 

 

3.3.1 Scia Engineer start op 

Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 
installatie beëindigd. 

3.3.2 Scia Engineer start niet op 

Indien de protectie niet correct geüpdate werd, zal bij het dubbelklikken op het 
symbool van Scia Engineer, het volgende scherm verschijnen: 

 
1. Scia Engineer kan niet opstarten zonder een correcte protectie. Druk op  

[Instellingen]  om de Protectie instellingen  te starten en de protectie te updaten. 
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2. Het venster van de Protectie instellingen verschijnt: 

 

Kies voor de optie Enkel op-zichzelf-staand  en druk op Importeer licentie 
bestand . 

Het licentiebestand zal automatisch geïmporteerd worden van de Scia protection 
server en het volgende venster verschijnt: 

 

Druk ok [OK] om deze melding af te sluiten. 

� Opmerking 

• Automatisch importeren van het licentiebestand van de Scia protection server kan 
enkel indien de sleutel op de computer aanwezig is en wanneer er internetverbinding 
is. 

Het importeren van dit licentiebestand is enkel mog elijk als de gebruiker 
schrijfrechten heeft op de folder van de licentiefi le (zie ook opmerking hieronder). 

• Het is mogelijk om het adres van de folder waarin d e licentiefile wordt 
weggeschreven te veranderen. Dit kan gedaan worden door met de rechtermuis 
knop bovenaan op de balk van de Protectie instellin gen te klikken: 

 
En hier te kiezen voor [Geavanceerde instellingen.. .]  
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Hier kan dan vervolgens het adres naar de folder wa arin de licentiefile wordt 
weggeschreven, veranderd worden. 

• Indien u een editie en dynamisch pakket van Scia En gineer heeft aangeschaft, zal u 
naast een SCIAxx.lic-bestand ook een SCIAxx.e2c-bes tand hebben. In dit geval moet 
u er voor zorgen dat beide bestanden in dezelfde fo lder staan op het moment dat u de 
licentiefile importeert. Indien u deze importeert v anaf de DVD is dit automatisch in 
orde. 

3. Van zodra het licentiebestand correct geïmporteerd is, kan de gebruiker een lijst van 
zijn commerciële modules zien door te klikken op “Uitklappen” in het venster van de 
protectie instellingen. 

4. Druk op [OK]  om de protectie instellingen te sluiten. 

5. Nu zal Scia Engineer 2011.0 automatisch opstarten. Indien het programma niet 
opstart, dubbelklik dan op het Scia Engineer 2011.0  symbool om het programma te 
starten. 

 
6. Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 

installatie beëindigd. 

 

3.3.3 Controleer op update   

In Scia Engineer is het mogelijk om te controleren of een nieuwere patch beschikbaar is 
via Help -> Controleer op update . 

Het is mogelijk om deze optie te deactiveren via de registry op de client computer via: 
HKEY_CURRENT_USER\Software\SCIA\Esa\11\Admin\Settings\EnableUpdateMenu = 
0 
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3.4 Update dongle 

Een update van een dongel houdt in dat het licentiebestand dient vervangen te worden. 
Deze update is nodig:  

a) wanneer er een hogere versie van Scia Engineer wordt geïnstalleerd; 

b) wanneer het aantal licenties voor bestaande modules gewijzigd is; 

c) wanneer nieuwe modules aangekocht werden. 

 

De dongel kan worden geupdate met de volgende stappen: 

1. Open de protectie instellingen  (onder Windows via “Start < All programs > Scia 
Engineer 2011.0 > Protectie instellingen”) 

2. druk op Importeer licentie bestand  in het venster van de Potectie instellingen 

3. De volgende melding zal verschijnen indien de licentiefile geupdate is: 

 

 

� Opmerking 

Automatisch importeren van het licentiebestand van de Scia protection server kan 
enkel indien de sleutel op de computer aanwezig is en wanneer er internetverbinding 
is  

Het importeren van dit licentiebestand is enkel mog elijk als de gebruiker 
schrijfrechten heeft op de folder van de licentiefi le (zie ook opmerking hieronder). 

Het is mogelijk om het adres van de folder waarin d e licentiefile wordt 
weggeschreven te veranderen. Dit kan gedaan worden door met de rechtermuis 
knop bovenaan op de balk van de Protectie instellin gen te klikken: 

 

 
 
En hier te kiezen voor [Geavanceerde instellingen.. .]  
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Hier kan dan vervolgens het adres naar de folder wa arin de licentiefile wordt 
weggeschreven, veranderd worden. 

 

3.5 Meerdere dongels samen gebruiken 
Het is mogelijk om alle dongels die op de computer zitten, samen te gebruiken. De LockID 
nummers van alle aangesloten dongels worden afgebeeld in het venster van de protectie 
instellingen:  

 
 
In de lijst van de beschikbare commerciële modules wordt de som van alle modules van 
alle licentiebestanden van alle dongels weergegeven. En deze kunnen allemaal tegelijk 
gebruikt worden in Scia Engineer. 

� Opmerking 

De optie [Importeer licentie bestand kan uitgevoerd  worden indien er meerdere 
dongels aanwezig zijn. Het is eveneens mogelijk om verschillende dongels te 
gebruiken met verschillende tijdsgerelateerde geldi gheid. Indien een bepaalde 
module op meerdere sleutels voorkomt, zal deze gebr uikt worden van het 
licentiebestand waarvoor deze nog het langste geldi g is (hoogste geldigheid in tijd).   
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4. Lokale Installatie, Netwerk Protectie  

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van een licentie 
server. Scia Engineer wordt lokaal op de client PC’s geïnstalleerd, enkel de protectie 
bevindt zich op de server. 

De netwerkprotectie kan geïnstalleerd worden op elke computer binnen het netwerk. Dit 
hoeft dus niet de domain of file server te zijn. Elk van de geautoriseerde modules kan 
een verschillend aantal licenties hebben welke simultaan kunnen gestart worden. Bij dit 
type van protectie krijgt de gebruiker alvorens Scia Engineer opgestart wordt, de keuze 
welke modules hij wenst te gebruiken en welke modules hij beschikbaar wenst te laten 
voor andere gebruikers. 

Scia Engineer maakt gebruik van een FlexNET netwerk dongle voor de floating 
protection. Deze wijziging zorgt ervoor dat het licentie bestand gekoppeld is aan de 
dongle en niet meer aan het MAC-adres van de server. Op die manier kan de protectie 
eenvoudig verplaatst worden naar een andere computer zonder dat het licentiebestand 
dient gewijzigd te worden. 

De installatie bestaat uit volgende stappen: 

• installatie of update van de FlexNet Netwerk protectie op de server, 

• installatie van Scia Engineer op de client computer. 

Het is aangeraden om de altijd de meest recent versie van FlexNET te installeren. Deze 
kan gevonden worden op de volgende site: 

http://www.scia-online.com/update/scia-engineer.php 

� Opgelet 

In dit hoofdstuk zijn 2 paragrafen beschreven voor de installatie van FlexNET 
Network Protection: 

• 4.1. Updating van een FlexNET Network Protectie 

• 4.2. Installatie van een nieuwe FlexNET Network Pro tectie 

 

De paragraaf die u dient te gebruiken hangt af van de versie van LMTools op de 
server. Ga in LMTools naar  ‘HELP -> About’. Hier v indt u de versie van LMTools 
terug: 

 

• Indien de versie gelijk of hoger is dan  v11.8,moet  u de protectie van Scia 
Engineer enkel updaten: Ga hiervoor naar paragraaf 4.1. 

• Indien de versie lager is dan v11.8, vereist de pro tectie van Scia Engineer een 
nieuwe installatie: Ga hiervoor naar paragraaf 4.2.  
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� Opgelet 

Wanneer de FlexNET netwerkprotectie op een nieuwe server wordt geïnstalleerd, is 
het noodzakelijk om eerst de modules terug te geven  van de oude server naar de Scia 
Activation Server alvorens deze te activeren op de nieuwe server (zie ook hoofdstuk 
4.2.6 voor het deactiveren van het licentiebestand) . 

 

4.1 Updaten van een FlexNET Network Protectie 

Een update van een bestaande Netwerk Floating Protectie houdt in dat het licentie 
bestand op de server dient vervangen te worden. Deze update is nodig:  

a) wanneer er een hogere versie van Scia Engineer wordt geïnstalleerd; 

b) wanneer het aantal licenties voor bestaande modules gewijzigd is; 

c) wanneer nieuwe modules aangekocht werden. 

� Opgelet 

Het updaten van de licentie file (*.*.lid) is enkel  mogelijk indien de laatste versie van 
de FlexNET Netwerk Protectie geïnstalleerd is. Dit kan gecontroleerd worden in 
‘LMTools -> Help -> About’: 

 
Deze versie moet gelijk zijn aan versie v11.8 zoals  hierboven aangeduid. 

Indien de versie lager is dan v11.8 moet u deze par agraaf overslaan en verder gaan 
naar hoofdstuk ‘4.2 Installatie van de nieuwe FlexN ET protectie’. 

 

1. Voer ActivationUtility.exe uit. Standaard kan deze gevonden worden onder:  
         ‘C:\Program 
Files\SCIA\FlexNET\ActivationUtility\ActivationUtility.exe’ 

 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 
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2. Selecteer uw licentienummer en kies voor Reload Licence . 

3. De licentiefile is geüpdate. Kies voor [Close] . 

4. Ga verder naar hoofdstuk ‘4.3 Installatie van Scia Engineer op de client 
computer’. 

 

4.2 Installatie van de nieuwe FlexNET Netwerk protectie  

� Opgelet 

• Wanneer een oudere versie van FlexNET reeds geïnsta lleerd is, is het nodig het 
licentiebestand te deactiveren alvorens FlexNET te de-installeren! Deze procedure is 
beschreven in paragraaf 4.2.6.  

• Tijdens deze installatie wordt de nieuwste versie v an FlexNET en LMTools 
geïnstalleerd op de server (versie 11.8). Indien ee n oudere versie van LMTools reeds 
is geïnstalleerd, moet u deze eerst de-installeren.  

• Met de versie v11.8 van LMTools is het niet meer mo gelijk om met patch 2010.0.78 van 
Scia Engineer te werken. Alle andere patches zijn compatibel met deze versie van 
LMTools. 

De installatie van de FlexNet Netwerk protectie bestaat uit volgende stappen: 

• installatie van de FlexID Installer, 

• installatie van de FlexNET Netwerk protectie op de server, 

• aanpassen van de licentie bestand, 

• configuratie van de FlexNET Server. 

 

4.2.1 Installatie van de FlexID Network Dongle op de serv er 

Voor correcte werking van de FlexLM Dongle dient eerst het benodigde 
stuurprogramma geïnstalleerd te worden.  

Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Installeer FlexID Driver . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNet\FlexidInstaller.exe  waarbij X staat 
voor de aanduiding van het DVD-station. 

1. Volg de installatie-instructies op het scherm. Bij het venster Select Features  
maakt u de volgende keuze: 

- Parallelle dongle: Flexid 8  

  - USB dongle: Flexid 9  

2. Na het doorlopen van de installatie, dient de computer herstart te worden. 

3. Plaats de FlexID-dongle op een vrije poort van de computer. Voor een parallelle 
dongle wordt aangeraden deze dongle te plaatsen wanneer de computer is 
uitgeschakeld. 
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4.2.2 Installatie FlexNET Netwerk protectie op de server  

1. Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Install FlexNet . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNetSetup\Setup.exe  waarbij X 
staat voor de aanduiding van het DVD-station. 

2. Volg de installatie-instructies op het scherm. 

3. De FlexNet Netwerk Protectie wordt standaard geïnstalleerd in de map 
C:\Program Files\SCIA\FlexNet . 

 

4.2.3 Activeren van de licentie file 

1. Plaats de dongle op de server. 

2. Controleer in lmtools.exe of de drivers voor de flexID-dongle correct 
geïnstalleerd zijn: de FlexID van de dongle(-s) verschijnen in het tabblad 
System Settings . Standaard wordt lmtools.exe geïnstalleerd in de map: 
    C:\Program Files\SCIA\FlexNet. 

 

 

� Opmerking 

De dongle FlexID zal niet zichtbaar zijn wanneer u gebruik maakt van Remote 
Desktop of gebruik maakt van een proxy server. 

 

3. De Lock ID is geregistreerd in een .lid-bestand dat gevonden kan worden op de 
DVD. Dit bestand wordt gebruikt voor het activeren van de modules.  

Kies in het Installatie & Software -menu van de installatie-DVD voor Floating 
protection en vervolgens voor Run SCIA Activation Utility . Dit 
stuurprogramma kan ook manueel geïnstalleerd worden via 
X:\Tools\ActUtility\ActivationUtility.exe  waarbij X staat voor de aanduiding 
van het DVD-station. Er is een ook snelkoppeling naar dit stuurprogramma 
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aanwezig op het Bureaublad van de computer onder de naam Activation 
Utility . 

4. Voer ActivationUtility.exe uit. 

 

Kies voor [Read Lock ID]  

 

Deze Lock ID is geregistreerd in SCIAxxxxxx.lid-bestand, waarbij xxxxxx staat 
voor de nummer van uw dongle. Dit nummer staat op de dongle zelf, zoals 
hieronder wordt getoond: 

 

Dongle Bestand: 

 

 

SCIA630505.lid 

 

De gegevens in dit bestand samen met de aanwezigheid van de dongle op de 
server zullen geconverteerd worden tot een .lic-bestand Dit .lic-bestand zal 
gebruikt worden door FlexNET om Scia Engineer op te starten. 

Selecteer de correcte .lid-bestand, dat overeenkomt met uw donglenummer en 
klik op [Open] . 
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5. Het nummer van uw licentiebestand zal in het FlexNET activation utility venster 
verschijnen. 

 

Selecteer dit nummer en kies [Activate licence] 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 

 

6. Vervolgens zal de blauwe cirkel voor het nummer groen worden. Dit betekent 
dat het licentiebestand gebruikt wordt. 

 

Klik op [Close] 

 

4.2.4 Configuratie van de FlexNET server 

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, Esa Prima WIn, ..) werd FlexLM gebruikt. 
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� Opgelet 

Indien u wilt werken met versie 2010.0 én een ouder e versie (2009.0, 2008.1, Esa 
Prima Win, ...), is het nodig om de stappen van de volgende paragraaf (‘Configuratie 
van de FlexNET Server voor alle versies’) uit te vo eren en deze paragraaf 
(‘Configuratie van de FlexNET server’) over te slaa n. 

Indien u enkel met versies 2010.0 en nieuwer wilt w erken, kunt u deze paragraaf 
volgen en kunt u volgende paragraaf ‘Configuratie v an de FlexNET Server voor alle 
versies’ overslaan. 

 

1. Navigeer via Windows Verkenner naar:     
 C:\Program Files\SCIA\FlexNET  . 

2. Start het bestand lmtools.exe  . 

 

3. Op het tabblad Config Services kan het pad naar de licentiebestand (Path to 
the license file ) gevonden worden. 

� Opmerking 

Het SCIA_Software.lic-bestand wordt gegenereerd wan neer de licentie file geüpdate 
wordt met FlexNET activation utility. Standaard zal  dit bestand TCP 27000 gebruiken.  

Indien de gebruiker een andere TCP poort wil gebrui ken (bv. 7282), is het mogelijk 
door deze file aan te passen. Open hiervoor de best and 
(C:\ProgramFiles\SCIA\FLEXnet\SCIA_Software.lic) en  voer het nummer van de TCP 
poort in achter de eerste lijn. 

Standaard zal de vendor daemon willekeurig een vrije poort gebruiken voor zijn 
communicatie met de client computer. Ook deze TCP-poort kan aangepast en/of 
gedefinieerd worden in het licentiebestand. Hiervoo r moet de rij ‘VENDOR SCIA’ 
veranderd worden in bijvoorbeeld ‘VENDOR SCIA PORT= 7283’. 
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Het SCIA_Software .lic-bestand wordt onmogelijk door het specifieke sign van het 
bestand: het bestand wordt onbruikbaar bij Iedere a ndere aanpassing 

4. Ga naar het tabblad Start/Stop/Reread . 

5. Selecteer de zonet aangemaakte License Manager (FlexNET SCIA). 

6. Druk op [Start Server] . 

Hierdoor werd de server gestart en zijn de licenties beschikbaar. 

 

4.2.5 Configuratie van de FlexNET Server voor alle versie s 

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, 2007.0, …) werd FlexLM gebruikt. 

� Opgelet 

Indien u wilt werken met versies 2010.0 en hoger, m aar ook met oudere versies (bv. 
2009.0, 2008.1, Esa Prima Win, ...) is het nodig de  stappen uit te voeren onder deze 
paragraaf.  

Indien u enkel met versies 2010.0 en hoger wilt wer ken, mag u deze paragraaf 
overslaan. 

1. Open LMTools (C:\Program Files\Scia\FlexNET). 

2. Kopieer de oude .dat-bestand naar ‘C:\Program Files\Scia\FlexNET’. 
Standaard stond deze file in C:\FlexLM. Dit .dat-bestand zorgt voor de 
protectie voor versie 2009.0 en ouder. 

3. Open dit .dat-bestand. 

4. In dit .dat-bestand staat de locatie van ‘scia.exe’ op de tweede lijn (standaard: 
C:\FlexLM\scia.exe): 
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5. Verwijder dit pad van het oude scia.exe-bestand: 

 

6. Verander de FlexNet SCIA Service en verander hier het pad van het 
licentiebestand naar het pad van het .dat-bestand: 

 

7. Vink beide opties ‘Start Server at Power Up’ en ‘Use services’ aan. 

8. Ga naar het tabblad ‘Start/Stop/Reread’. 

9. Druk op [Reread License file]. 

10. Druk op [Start Server] (Onderaan zal de melding ‘Server Start Successful’ 
verschijnen). 

11. Soms is het nodig om de server opnieuw op te starten, maar u kan steeds 
vooraf proberen of het programma werkt zonder deze herstart. 

12.  De volgende paragraaf mag u nu overslaan en vervolgens verder gaan met 
de installatie van Scia Engineer. 

 

4.2.6 Instellingen op de server 
Voor servers met een windows versie ouder dan windows7 moeten de poorten die 
gebruikt worden door FlexNET (standaard 27000) open gezet worden. 

Indien een Windows7 -machine gebruikt wordt als server, moeten de poorten niet 
opengezet worden, maar hier moeten de programma's toegevoegd worden die 
toegelaten zijn voor een correcte protectie van Scia Engineer.  
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Concreet betekent dit dat de volgende programma’s toegelaten moeten worden: 
lmgrd.exe, scia.exe en lmtools.exe 
 

4.2.7 Deactiveer het licentiebestand 

Het deactiveren van het licentiebestand is noodzakelijk wanneer de sleutel en de protectie 
van de ene server naar een andere verplaatst wordt. In dit geval is het nodig om eerst de 
licentie file te deactiveren op de oorspronkelijke server alvorens deze te activeren op de 
nieuwe server. Hiervoor kunnen volgende stappen gevolgd worden: 

1. Navigeer met Windows Verkenner naar             C:\Program 
Files\SCIA\FlexNET\ActivationUtility 

2. Start ActivationUtility.exe . 

3. Selecteer het Licentienummer en kies voor [Return License]. 

4. Druk op [Close]. 

 

4.3 Installatie van Scia Engineer op de client computer 

1. Plaats de installatie-DVD van Scia Engineer in de DVD-lade van de computer. 
Het startscherm verschijnt automatisch. Kies de gewenste taal om het menu te 
doorlopen. Het Hoofdmenu  verschijnt: 

  

In het Hoofdmenu  kiest u vervolgens de optie Installatie & Software . 
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2. In het Installatie & Software menu kiest u vervolgens de optie Installeer  
Scia Engineer . 

 

 

� Opmerking 

Indien het startscherm niet kan getoond worden door  het ontbreken van de 
benodigde ActiveX component, kan de installatie ook  manueel gestart worden via 
Windows Verkenner. Start het bestand X:\Setup\DISK1 \Setup.exe waarbij X staat voor 
de aanduiding van het DVD-station. 

 

3. In het Kies het Setup Type om te installeren –menu, kiest u vervolgens de 
optie Installeer Enkel op-zichzelf-staand  
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4. In het daarop volgend dialoogvenster kan de gewenste taal voor de installatie 
gekozen worden: 

 

De taal welke gekozen wordt voor de installatie is ook de standaard taal die 
gekozen wordt voor de help bestanden van Scia Engineer. 

5. Het welkomstscherm voor de installatie verschijnt. 
Druk op [Volgende]  om verder te gaan. 

6. Bij de Klantgegevens  kan de bedrijfsnaam en de gebruikersnaam worden 
ingevoerd. De bedrijfsnaam komt automatisch op het document van Scia 
Engineer. 

 

Druk op [Volgende]  om verder te gaan. 
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7. In het venster Doellocatie  kan het pad, waar de bestanden worden 
geïnstalleerd, worden ingesteld. Standaard gebeurt dit in de map Program Files. 
Het wordt aangeraden deze standaardlocatie te behouden. 

 

Druk op [Volgende]  om verder te gaan. 
 

8. In het venster Type installatie  kan de gewenste installatievorm gekozen 
worden. 

 

Druk op [Volgende]  om verder te gaan. 
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� Opmerking 

Om in het programma een andere taal voor de werkrui mte of de uitvoer te kunnen 
kiezen dient aan twee voorwaarden voldaan te zijn: 

• De desbetreffende taal dient geïnstalleerd te zijn.  

• De benodigde taalmodule dient actief te zijn in de dongle of op de server. 

Om één van de Scia Engineer plug-ins te installeren, dient de plug-in in de 
Aangepaste installatie geselecteerd te worden. 
De volgende plug-ins zijn beschikbaar: Tekla Structures plug-in, Revit Structure plug-
in, CADS RC Link Designer, BS2000, Pipeline Wizard,  Composite Beam, Composite 
Column, Arcelor Mittal-Cellular beams. 

 

9. In het venster Protectie standaard waarden  kunnen de default-instellingen 
gedaan worden voor de beveiliging. 

 

• Kies voor Enkel floating . 

• Vul het correcte adres in naar de Licentie server : 

o Bijvoorbeeld ‘27000@Server’ 

o Het nummer 27000 verwijst naar de gebruikte TCP-port. Standaard is 
deze poort 27000, maar deze kan aangepast worden (zie ook 
hoofdstuk 4.2.4).  

o De naam Server  moet vervangen worden door de naam van de 
Licentieserver. 

Druk op [Volgende]  om verder te gaan. 

 
  



Scia Engineer 

33 

� Opmerking 

Wanneer u een enkel-op-zichzelf-staande dongle gebr uikt en een FlexNET netwerk 
licentie, kies dan voor de optie ‘Eerst op-zichzelf -staand, dan floating’, of ‘Eerst 
floating, dan op-zichzelf-staand’. 

10. In het venster Standaardinstellingen programma  worden de 
standaardinstellingen gedaan met betrekking tot het hanteren van de nationale 
normen. 

 

Kies hier uw standaard keuze voor de Nationale norm en voor uw standaard 
meetsysteem. 

Druk op [Volgende]  om verder te gaan. 
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11. In het laatste venster zijn de door u gemaakte installatie-instellingen opgelijst. 
Zo kunt u eenvoudig controleren en na eventuele aanpassingen overgaan tot de 
effectieve installatie. Druk hiervoor op [Volgende] . 

 

12. Na installatie verschijnt de melding dat Scia Engineer met succes geïnstalleerd 
is. Druk op [Voltooien]  om de installatie te beëindigen. 
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� Opmerking 

Indien UAC (User Access Control) is geactiveerd, za l het volgende scherm 
verschijnen aan het einde van de installatie: 

 
 

Kies voor ‘Install this driver software anyway’ om de installatie te voltooien. 

 

� Let op! 

Voor het gebruik van Scia Engineer volstaan standaa rd gebruikersrechten, hier zijn 
geen Administrator rechten nodig.  

Wel dient de gebruiker lees- en schrijfrechten te h ebben op de mappen van Scia 
Engineer:  

Windows XP: C:\Documents and Settings\#USER#\ESA** 

Windows Vista, Windows 7: C:\USERS\#USER#\ESA** 

Waarbij ** staat voor de versie en #USER#  voor de gebruikers login naam.  

 

4.4 Start Scia Engineer 

Dubbelklik op het Scia Engineer 2011.0  symbool om het programma te starten. 
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4.4.1 Scia Engineer start op 

Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 
installatie beëindigd. 

 

4.4.2 Scia Engineer start niet op 

Indien de protectie niet correct geüpdate werd, zal bij het dubbelklikken op het 
symbool van Scia Engineer, het volgende scherm verschijnen: 

 
1. Scia Engineer kan niet opstarten zonder een correcte protectie. Druk op  [Yes]  om 

de Protectie instellingen  te starten en de protectie te updaten. 

2. Het venster van de Protectie instellingen verschijnt: 

• Activeer de optie Enkel floating  en vul het juiste pad in naar de Licence 
server: Kies voor Enkel floating . 

• Vul het correcte adres in naar de Licentie server: 

o Bijvoorbeeld ‘27000@Server’ 

o Het nummer 27000 verwijst naar de gebruikte TCP-poort. Standaard 
is dit poort 27000, maar dat kan aangepast worden (zie ook hoofdstuk 
4.2.4 [3]). 

o De naam Server  moet vervangen worden door de naam van de 
licentieserver. 
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Druk op [Toepassen / Herlezen]  

 

3. De beschikbare commerciële modules zullen in het venster verschijnen: 

 
Druk op [OK]  om de protectie instellingen te sluiten. 
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4. Dubbelklik op het Scia Engineer 2011.0  symbool om het programma te starten. 

 
5. Indien de protectie geüpdate is, zal Scia Engineer opstarten en is de installatie 

beëindigd. 

 

4.4.3 Controleer op update   

In Scia Engineer is het mogelijk om te controleren of een nieuwere patch beschikbaar is 
via Help -> Controleer op update . 

Het is mogelijk om deze optie te deactiveren via de registry op de client computer via: 
HKEY_CURRENT_USER\Software\SCIA\Esa\10.1\Admin\Settings\EnableUpdateMenu 
= 0 



Scia Engineer 

39 

5. Server installatie 

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van Scia Engineer 
en de protectie op een licentie server.  

De installatie bestaat uit volgende stappen: 

• installatie of update van de FlexNet Netwerk protectie op de server. 

• installatie van Scia Engineer op de server. 

• installatie van Scia Engineer type client op de gebruikers PC. 

 

Het is aangeraden om de altijd meest recente versie van FlexNET te installeren. Deze 
kan gevonden worden op de volgende site:                             http://www.scia-
online.com/update/scia-engineer.php 

� Opgelet 

Wanneer de FlexNET netwerk protectie op een nieuwe server wordt geïnstalleerd, is 
het noodzakelijk om eerst de modules ‘terug te geve n’ van de oude server naar de 
Scia Activation Server alvorens deze te activeren op de nieuwe server (zi e ook 
hoofdstuk 5.2.6 voor het deactiveren van het licent iebestand). 

5.1 Updaten van een FlexNET Network Protection 

Een update van een bestaande Netwerk Floating Protectie houdt in dat het licentie 
bestand op de server dient vervangen te worden. Deze update is nodig:  

b) wanneer er een hogere versie van Scia Engineer wordt geïnstalleerd; 

c) wanneer het aantal licenties voor bestaande modules gewijzigd is; 

d) wanneer nieuwe modules aangekocht werden. 

� Opgelet 

Het updaten van de licentie file (*.*.lid) is enkel  mogelijk indien de laatste versie van 
de FlexNET Netwerk Protectie geïnstalleerd is. Dit kan gecontroleerd worden in 
‘LMTools -> Help -> About’: 

 
Deze versie moet gelijk zijn aan versie v11.8 zoals  hierboven aangeduid. 

Indien de versie lager is dan v11.8 moet u deze par agraaf overslaan en verder gaan 
naar hoofdstuk ‘4.2 Installatie van de nieuwe FlexN ET protectie’. 
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1. Voer ActivationUtility.exe uit. Standaard kan deze gevonden worden onder:  
         ‘C:\Program 
Files\SCIA\FlexNET\ActivationUtility\ActivationUtility.exe’ 

 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 

 

2. Selecteer uw licentienummer en kies voor Reload Licence . 

3. De licentiefile is geüpdate. Kies voor [Close] . 

4. Ga verder naar hoofdstuk ‘4.3 Installatie van Scia Engineer op de client 
computer’. 

 

5.2 Installatie van de nieuwe FlexNET Netwerk protectie  

� Opgelet 

• Wanneer een oudere versie van FlexNET reeds geïnsta lleerd is, is het nodig het 
licentiebestand te deactiveren alvorens FlexNET te de-installeren! Deze procedure is 
beschreven in paragraaf 4.2.6.  

• Tijdens deze installatie wordt de nieuwste versie v an FlexNET en LMTools 
geïnstalleerd op de server (versie 11.8). Indien ee n oudere versie van LMTools reeds 
is geïnstalleerd, moet u deze eerst de-installeren.  

• Met de versie v11.8 van LMTools is het niet meer mo gelijk om met patch 2010.0.78 van 
Scia Engineer te werken. Alle andere patches zijn compatibel met deze versie van 
LMTools. 

De installatie van de FlexNet Netwerk protectie bestaat uit volgende stappen: 

• installatie van de FlexID Installer, 

• installatie van de FlexNET Netwerk protectie op de server, 

• aanpassen van de licentie bestand, 

• configuratie van de FlexNET Server. 
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5.2.1 Installatie van de FlexID Network Dongle op de serv er 

Voor correcte werking van de FlexLM Dongle dient eerst het benodigde 
stuurprogramma geïnstalleerd te worden.  

Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Installeer FlexID Driver . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNet\FlexidInstaller.exe  waarbij X staat 
voor de aanduiding van het DVD-station. 

1. Volg de installatie-instructies op het scherm. Bij het venster Select Features  
maakt u de volgende keuze: 

- Parallelle dongle: Flexid 8  

  - USB dongle: Flexid 9  

2. Na het doorlopen van de installatie, dient de computer herstart te worden. 

3. Plaats de FlexID-dongle op een vrije poort van de computer. Voor een parallelle 
dongle wordt aangeraden deze dongle te plaatsen wanneer de computer is 
uitgeschakeld. 

 

5.2.2 Installatie FlexNET Netwerk protectie op de server  

1. Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Install FlexNet . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNetSetup\Setup.exe  waarbij X 
staat voor de aanduiding van het DVD-station. 

2. Volg de installatie-instructies op het scherm. 

3. De FlexNet Netwerk Protectie wordt standaard geïnstalleerd in de map 
C:\Program Files\SCIA\FlexNet . 

 

5.2.3 Activeren van de licentie file 

1. Plaats de dongle op de server. 

2. Controleer in lmtools.exe of de drivers voor de flexID-dongle correct 
geïnstalleerd zijn: de FlexID van de dongle(-s) verschijnen in het tabblad 
System Settings . Standaard wordt lmtools.exe geïnstalleerd in de map: 
    C:\Program Files\SCIA\FlexNet. 
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� Note 

De dongle FlexID zal niet zichtbaar zijn wanneer u gebruik maakt van Remote 
Desktop of gebruik maakt van een proxy server. 

 

3. De Lock ID is geregistreerd in een .lid-bestand dat gevonden kan worden op 
de DVD. Dit bestand wordt gebruikt voor het activeren van de modules.  

 

Kies in het Installatie & Software -menu van de installatie-DVD voor 
Floating protection en vervolgens voor Run SCIA Activation Utility . Dit 
stuurprogramma kan ook manueel geïnstalleerd worden via 
X:\Tools\ActUtility\ActivationUtility.exe  waarbij X staat voor de aanduiding 
van het DVD-station. Er is een ook snelkoppeling naar dit stuurprogramma 
aanwezig op het Bureaublad van de computer onder de naam Activation 
Utility .  

 

4.  Voer ActivationUtility.exe uit. 

 

Kies voor [Read Lock ID]  
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Deze Lock ID is geregistreerd in SCIAxxxxxx.lid-bestand, waarbij xxxxxx staat 
voor de nummer van uw dongle. Dit nummer staat op de dongle zelf, zoals 
hieronder wordt getoond: 

 

Dongle Bestand: 

 

 

SCIA630505.lid 

 

De gegevens in dit bestand samen met de aanwezigheid van de dongle op de 
server zullen geconverteerd worden tot een .lic-bestand Dit .lic-bestand zal 
gebruikt worden door FlexNET om Scia Engineer op te starten. 

Selecteer de correcte .lid-bestand, dat overeenkomt met uw donglenummer en 
klik op [Open] . 

 

5. Het nummer van uw licentiebestand zal in het FlexNET activation utility venster 
verschijnen. 

 

Selecteer dit nummer en kies [Activate licence] 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 
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6. Vervolgens zal de blauwe cirkel voor het nummer groen worden. Dit betekent dat 
het licentiebestand gebruikt wordt. 

 

Klik op [Close] 

 

5.2.4 Configuratie van de FlexNET server 

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, Esa Prima WIn, ..) werd FlexLM gebruikt. 

� Opgelet 

Indien u wilt werken met versie 2010.0 én een ouder e versie (2009.0, 2008.1, Esa 
Prima Win, ...), is het nodig om de stappen van de volgende paragraaf (‘Configuratie 
van de FlexNET Server voor alle versies’) uit te vo eren en deze paragraaf 
(‘Configuratie van de FlexNET server’) over te slaa n. 

Indien u enkel met versies 2010.0 en nieuwer wilt w erken, kunt u deze paragraaf 
volgen en kunt u volgende paragraaf ‘Configuratie v an de FlexNET Server voor alle 
versies’ overslaan. 

 

1. Navigeer via Windows Verkenner naar:     
 C:\Program Files\SCIA\FlexNET  . 
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2. Start het bestand lmtools.exe  . 

 

3. Op het tabblad Config Services kan het pad naar de licentiebestand (Path to 
the license file ) gevonden worden. 

� Opmerking 

Het SCIA_Software.lic-bestand wordt gegenereerd wan neer de licentie file geüpdate 
wordt met FlexNET activation utility. Standaard zal  dit bestand TCP 27000 gebruiken.  

Indien de gebruiker een andere TCP poort wil gebrui ken (bv. 7282), is het mogelijk 
door deze file aan te passen. Open hiervoor de best and 
(C:\ProgramFiles\SCIA\FLEXnet\SCIA_Software.lic) en  voer het nummer van de TCP 
poort in achter de eerste lijn. 

Standaard zal de vendor daemon willekeurig een vrije poort gebruiken voor zijn 
communicatie met de client computer. Ook deze TCP-poort kan aangepast en/of 
gedefinieerd worden in het licentiebestand. Hiervoo r moet de rij ‘VENDOR SCIA’ 
veranderd worden in bijvoorbeeld ‘VENDOR SCIA PORT= 7283’. 

 

Het SCIA_Software .lic-bestand wordt onmogelijk door het specifieke sign van het 
bestand: het bestand wordt onbruikbaar bij Iedere a ndere aanpassing 

4. Ga naar het tabblad Start/Stop/Reread . 

5. Selecteer de zonet aangemaakte License Manager (FlexNET SCIA). 

6. Druk op [Start Server] . 

Hierdoor werd de server gestart en zijn de licenties beschikbaar. 
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5.2.5 Configuratie van de FlexNET Server voor alle versie s 

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, 2007.0, …) werd FlexLM gebruikt. 

� Opgelet 

Indien u wilt werken met versies 2010.0 en hoger, m aar ook met oudere versies (bv. 
2009.0, 2008.1, Esa Prima Win, ...) is het nodig de  stappen uit te voeren onder deze 
paragraaf.  

Indien u enkel met versies 2010.0 en hoger wilt wer ken, mag u deze paragraaf 
overslaan. 

1. Open LMTools (C:\Program Files\Scia\FlexNET). 

2. Kopieer de oude .dat-bestand naar ‘C:\Program Files\Scia\FlexNET’. Standaard 
stond deze file in C:\FlexLM. Dit .dat-bestand zorgt voor de protectie voor versie 
2011.0 en ouder. 

3. Open dit .dat-bestand. 

4. In dit .dat-bestand staat de locatie van ‘scia.exe’ op de tweede lijn (standaard: 
C:\FlexLM\scia.exe): 

 

5. Verwijder dit pad van het oude scia.exe-bestand: 

 

6. Verander de FlexNet SCIA Service en verander hier het pad van het 
licentiebestand naar het pad van het .dat-bestand: 
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7. Vink beide opties ‘Start Server at Power Up’ en ‘Use services’ aan. 

8. Ga naar het tabblad ‘Start/Stop/Reread’. 

9. Druk op [Reread License file]. 

10. Druk op [Start Server] (Onderaan zal de melding ‘Server Start Successful’ 
verschijnen). 

11. Soms is het nodig om de server opnieuw op te starten, maar u kan steeds 
vooraf proberen of het programma werkt zonder deze herstart. 

12.  De volgende paragraaf mag u nu overslaan en vervolgens verder gaan met 
de installatie van Scia Engineer. 

 

5.2.6 Instellingen op de server 
Voor servers met een windows versie ouder dan windows7 moeten de poorten die 
gebruikt worden door FlexNET (standaard 27000) open gezet worden. 

Indien een Windows7 -machine gebruikt wordt als server, moeten de poorten niet 
opengezet worden, maar hier moeten de programma's toegevoegd worden die 
toegelaten zijn voor een correcte protectie van Scia Engineer. Concreet betekent dit dat 
de volgende programma’s toegelaten moeten worden: lmgrd.exe, scia.exe en 
lmtools.exe 
 

5.2.7 Deactiveer het licentiebestand 

Het deactiveren van het licentiebestand is noodzakelijk wanneer de sleutel en de 
protectie van de ene server naar een andere verplaatst wordt. In dit geval is het nodig 
om eerst de licentie file te deactiveren op de oorspronkelijke server alvorens deze te 
activeren op de nieuwe server. Hiervoor kunnen volgende stappen gevolgd worden: 
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1. Navigeer met Windows Verkenner naar              
C:\Program Files\SCIA\FlexNET\ActivationUtility 

2. Start ActivationUtility.exe . 

3. Selecteer het Licentienummer en kies voor [Return License]. 

4. Druk op [Close]. 

 

5.3 Nieuwe netwerkinstallatie 

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van Scia Engineer 
op het netwerk. Bij deze installatie wordt Scia Engineer volledig op de server 
geïnstalleerd en kan het programma van op elk workstation in het netwerk gestart 
worden 

1. Verifieer de operating systems van de client PC’s. 

2. Maak op de server een map met alle bestanden voor de installatie van Scia 
Engineer er in. Kopieer de Disk1-map eveneens in deze map en share deze 
map + alle subfolders op het netwerk, bijvoorbeeld onder de naam ‘scia’. 

3. Installeer Scia Engineer op de server vanuit \\server\Scia met het commando: 
SETUP.EXE /v"INSTALLATION=server"   
Er wordt gevraagd naar de doellocatie: geef bijvoorbeeld Z:\Program 
Files\Scia\Engineer 2009.0 
 
Opgelet, tijdens deze stap krijgt U 4 waarschuwingsberichten van het Operating 
System. 

4. Verbind de Z-schijf van het workstation in verbinding met de shared map op de 
server aangemaakt in stap 2 (deze moet dezelfde zijn als de doellocatie van de 
vorige stap). 

5. Installeer Scia Engineer op de client vanuit Z:\Disk1 met het commando: 
 SETUP.EXE /v"INSTALLATION=client" 
Er wordt gevraagd naar de netwerk installatiemap (vanuit stap 3). 

Opgelet, voor deze stap is het noodzakelijk dat men over ten minste 
Administrator rechten beschikt! 
Opgelet, het is niet mogelijk  om een client installatie te doen op dezelfde 
computer als van waaruit de server installatie werd gedaan. 
Opgelet, de Scia Engineer Plug-ins worden niet  geïnstalleerd. 

6. Nu kan elke gebruiker (zonder speciale rechten) Scia Engineer gebruiken van 
op dit workstation. De mapped drive dient wel dezelfde te zijn als diegene die 
gebruikt werd bij stap 4 en dezelfde als de doellocatie van stap 2. 
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5.4 Silent install 

Een silent install  op de client PC’s kan als volgt uitgevoerd worden: 

1. Op de eerste client PC, run Setup.exe /L1033 /v”INSTALLATION=client” /r  

2. Hierbij wordt een bestand Setup.iss aangemaakt in de C:\WINDOWS map van de 
client PC. Dit bestand bevat alle informatie voor de silent install. Kopieer dit 
bestand Setup.iss naar Z:\Disk1. 

Op alle volgende client PC’s, doe een silent install met het volgende commando: 
Setup.exe /L1033 /v”INSTALLATION=client” /s . 

 

5.5 Lokale bestanden 

Het wordt aangeraden de TEMP-map, waar de tijdelijke bestanden worden opgeslagen, 
niet op de server te plaatsen, maar lokaal op elk werkstation. Dit kan binnen Scia 
Engineer worden ingesteld via Instellingen -> Opties -> Bestanden . 

Eveneens de projectbestanden, templates, gebruikersblokken, ... worden bij voorkeur 
lokaal geplaatst. 
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6. Verwijderen van Scia Engineer 

6.1 Verwijder Scia Engineer met Add/Remove Programs in Windows 

Scia Engineer kan verwijderd (‘gedeïnstalleerd’) worden zoals ieder ander 
softwarepakket onder Windows: 

1. Ga naar Add or Remove Programs  via Start > Settings > Control Panel > 
Add or Remove Programs . 

2. Een lijst met geïnstalleerde software verschijnt. Selecteer Scia Engineer en druk 
op [Change/Remove] . 

3. In het dialoogvenster dat verschijnt, kiest u de optie Verwijderen . 

 

4. Druk op [Volgende]  om het verwijderingsproces te doorlopen. 

Na dit verwijderingsproces blijven nog instellingen van het programma over in het 
Register van Windows (‘Registry’). Deze sporen kunnen handmatig verwijderd 
worden. Het verwijderen van deze sporen kan noodzakelijk zijn wanneer problemen 
ondervonden worden bij een nieuwe installatie. 

1. Open de Uitvoeren  dialoogbox via Start > Run . 

2. Typ regedit  en druk op [OK] . 
 
Opgelet, voor deze stap is het noodzakelijk dat de gebruiker over ten minste 
Administrator-rechten beschikt. 
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3. De Registry Editor  verschijnt: 
 

 

4. Ga naar volgende key’s en verwijder ze met de Delete  toets. 
 
HKEY_CURRENT_USER\Software\SCIA\ESA\* 
HKEY_LOCAL_MACHINE\Software\SCIA\ESA\* 
Waarbij * staat voor de versie. 

5. Sluit de Registry Editor  via File > Exit . 

Na het verwijderingsproces blijft volgende map nog op de harde schijf. Deze kan manueel 
verwijderd worden: 

32 bits computer:   C:\Program Files\SCIA\ESA** 

64 bits computer:  C:\Program Files (x86)\SCIA\Engineer** 

 

Ook volgende folders blijven nog staan en kunnen manueel gewist worden: 

Windows XP: C:\Documents and Settings\#USER#\ESA** 

C:\Documents and Settings\#USER#\My Documents\ESA** 
 

Windows Vista en Windows 7 :  C:\Users\#User#\Esa** 

    C:\Users\#User#\Documents\Esa** 
 

Waarbij ** telkens staat voor het versienummer. 

� Attention 

Deze mappen kunnen via Windows Verkenner verwijderd  worden. Hierbij dient wel 
opgemerkt te worden dat er zich in de eerste map pr ojecten kunnen bevinden en de 
gebruiker er zich dus dient van te vergewissen dat deze verwijderd mogen worden. 

 

6.2 Verwijder Scia Engineer zonder Add/Remove Programs in Windows 

Het kan gebeuren dat Scia Engineer niet gedeïnstalleerd kan worden via “Add/Remove 
programs” van Windows. Wanneer dit dan geprobeerd wordt, geeft Windows een 
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foutmelding of soms is zelfq Scia Engineer niet toegevoegd aan “Add/Remove 
Programs”. Het is dan niet mogelijk om het programma te deïnstalleren zoals in de 
vorige paragraaf beschreven.  

Dit probleem kan zich voordoen bij ieder programma gebaseerd op Windows. 

Scia Engineer kan dan gemakkelijk gedeïnstalleerd worden met de volgende procedure: 

Ga naar ‘Start’ -> ‘Run’  

Typ vervolgens het volgende commando in het dialoogvenster dat dan verschijnt:  

msiexec /x {A987CA63-95E7-47E5-AA08-38C0D84BB03C}  

Dit commando zal dezelfde procedures uitvoeren als via Add/Remove Programs en 
Scia Engineer zal gedeïnstalleerd worden. 

 


